
Bài 5: CÁC THAO TÁC CƠ BẢN TRÊN BẢNG 

 

Câu 1: Để xóa một bản ghi trong bảng cần thực hiện: mở bảng, chọn bản ghi và: 

A. Nháy nút lệnh Cut Record 

B. Nhấn phím Delete 

C. Nháy nút lệnh Earse Record 

D. Tất cả đều đúng 

Câu 2: Hãy chọn đáp án sai? 

A. Sử dụng lọc theo lựa chọn để tìm nhanh các bản ghi có dữ liệu trùng với ô 

đang chọn. 

B. Sử dụng lọc theo mẫu để tìm các bản ghi có dữ liệu trùng với ô đang chọn và 

thêm một số tiêu chí khác. 

C. Sử dụng lọc theo mẫu để tìm các bản ghi thỏa mãn các tiêu chí phức tạp. 

D. Câu A và C đúng 

Câu 3: Hãy đánh dấu ✓ thích hợp vào ô tương ứng của cột Đúng/Sai: 

Thông tin Đúng Sai 

Một trường chứa một đơn vị thông tin bên trong bản ghi   

Có thể có các khóa chính giống nhau trong bảng   

Tên trường có thể chứa các kí tự số và không dài hơn 64 kí tự   

Chỉ có thể thực hiện các phép toán số học trên dữ liệu của trường 

kiểu số 
  

Có thể sử dụng phím Tab để di chuyển giữa các ô trong bảng ở 

chế độ trang dữ liệu 
  

Nếu độ dài của trường kiểu Text không được chỉ rõ thì Access 

gán cho nó là 25  
  

 



Bài 6: BIỂU MẪU 

 

Câu 1: Việc nhập dữ liệu có thể được thực hiện một cách thuận lợi thông qua: 

A. Định dạng hàng.     B. Định dạng cột. 

C. Biểu mẫu.       D. Trang dữ liệu. 

Câu 2: Khi tạo ra một biểu mẫu để nhập dữ liệu thì ta bắc buộc phải: 

A. xác định hành động cho biểu mẫu đó.  B. chọn bố cục cho biểu mẫu 

C. xác định dữ liệu nguồn (record source).  D. nhập tên cho biểu mẫu. 

Câu 3: Hãy ghép mỗi dòng ở cột bên trái với một dòng ở cột bên phải cho thích hợp: 

 

1. Chế độ biểu mẫu a. Người thiết kế CSDL 

2. Chế độ trang dữ liệu b. Người dùng 

3. Chế độ thiết kế c. Cả người dùng và người thiết kế 

 

Câu 4: Hãy ghép mỗi dòng ở cột bên trái với một dòng ở cột bên phải cho thích hợp: 

1. Chế độ biểu mẫu a. Có giao diện thân thiện 

2. Chế độ trang dữ liệu b. Thường được sử dụng để cập nhật dữ liệu 

3. Chế độ thiết kế c. Được sử dụng để làm việc trên cấu trúc của biểu mẫu 

 d. Có thể được sử dụng để cập nhật dữ liệu 

 

 



Bài 7 - 8 - 9 

 

Câu 1: Để lấy thông tin theo một điều kiện xác định từ một csdl có sẵn, dùng truy 

vấn nào trong các truy vấn sau: 

A. update query B. make table query C. select query D. crosstab 

query 

Câu 2: Trong các hàm sau đây hàm nào không được sử dụng trong truy vấn? 

A. Total B. Count C. Max D. Sum 

Câu 3: Muốn xóa liên kết giữa hai bảng, trong cửa sổ Relatioships ta thực hiện: 

A. Chọn đường liên kết giữa hai bảng đó và nhấn phím Delete. 

B. Tất cả đều sai. 

C. Chọn hai bảng và nhấn phím Delete. 

D. Chọn tất cả các bảng và nhấn phím Delete. 

Câu 4: Phép toán :”Ho”&”Ten” trả lại kết quả nào trong các kết quả sau? 

A. HoTen  B. Ho Ten  

C. Ho “” Ten  D. “Ho”& “” “Ten” 

Câu 5: Cho Table KHACHHANG(makh,hoten,diachi), tạo Query để lọc ra danh 

sách những người có họ Nguyễn, nhập vào ô giao nhau của trường hoten và dòng 

Criteria: 

A. Like  "Nguyễn*" hoặc Like  Nguyễn* B. In(Nguyễn*) 

C. Nguyễn* D. LikeNguyễn* 

Câu 6: Các điều kiện nào trong các điều kiện sau không được dùng trong truy vấn? 

A. Các phép so sánh =,  <>,  <=, >= 

B. Phép in 

C. Các phép toán logic and, or, not, between... and 

D. So sánh xâu ký tự : is=”xâu ký tự cần so sánh” 



Câu 7: Khi kích vào biểu tượng   trên thanh công cụ, trên khung lưới của Query 

xuất hiện dòng nào? 

A. Total. B. Delete. C. Append to. D. Update To. 

Câu 8: Truy vấn dữ liệu có nghĩa là: 

A. Tìm kiếm và hiển thị dữ liệu. B. Xóa các dữ liệu không cần đến nữa. 

C. In dữ liệu. D. Cập nhật dữ liệu. 

Câu 9: Để chọn nguồn dữ liệu cho một report, trên hộp thoại Properties ta chọn 

thành phần nào? 

A. Event\ Record source B. Data\ Record source 

C. Other\ Record source D. Format\ Record source 

Câu 10: Để đưa giá trị ngày tháng năm, giờ phút giây hiện thời của hệ thống vào 

trong report, ta sử dụng hàm nào? 

A. Pages() B. Today() C. Now() D. Page() 

Câu 11: Đối tượng nào không dùng để cập nhật dữ liệu: 

A. Mẫu hỏi; B. Báo cáo; C. Biểu mẫu D. Bảng; 

Câu 12: Trong cửa sổ Design View của 1 Query, muốn nhóm thành từng nhóm các 

mẫu tin có dữ liệu giống nhau, trên dòng TOTAL ta chọn phép toán nào sau đây? 

A. Sum B. Group by C. Count D. Avg 

Câu 13: Muốn tạo nhóm trong Report ta làm thế nào? 

A. Insert\ Sorting and Grouping B. Insert\ Grouping 

C. View\ Sorting and Grouping D. View\ Grouping 

Câu 14: Phần nào của báo cáo được in sau mỗi nhóm bản ghi (báo cáo có gộp 

nhóm)? 

A. Đầu nhóm.  B. Tiêu đề chi tiết.  

C. Cuối nhóm.  D. Tiêu đề tổng con. 

Câu 15: Để cập nhật thông tin mới vào csdl có sẵn dùng truy vấn nào? 

A. appen query B. make table query C. select query D. update query 



Câu 16: Phần nào của báo cáo được in một lần duy nhất khi in báo cáo có 5 trang? 

A. Footer (chân trang). B. Report footer (chân báo cáo). 

C. Tất cả đều đúng. D. Header (đầu trang). 

Câu 17: Báo cáo có ưu điểm gì so với các đối tượng khác 

A. Sắp xếp dữ liệu nhanh 

B. Có thể định dạng và in văn bản 

C. Tổng hợp dữ liệu được từ nhiều bảng 

D. Trình bày được nội dung theo mẫu văn bản qui định 

Câu 18: Câu nào đúng khi nói về mẫu hỏi? 

A. Là đối tượng có thể được tạo bởi nhiều cách nhất. 

B. Là đối tượng có thể lọc ra các bản ghi thỏa mãn điều kiện. 

C. Là đối tượng duy nhất trong Microsoft Access có thể kết xuất thông tin từ   

nhiều bảng. 

D. Là đối tượng không thay đổi được sau khi thiết kế. 

Câu 19: Với báo cáo, ta không thể làm được việc gì trong những việc sau? 

A. Gộp nhóm dữ liệu. 

B. Chọn trường đưa vào báo cáo. 

C. Chèn hình ảnh cho báo cáo sinh động. 

D. Lọc những bản ghi thỏa mãn một điều kiện nào đó. 

Câu 20: Access dùng quan hệ để: 

A. Đảm bảo tổng hợp, tìm kiếm, sắp xếp dữ liệu của các bảng từ nhiều tệp dữ liệu 

khác nhau. 

B. Đảm bảo những ràng buộc toàn vẹn giữa các bảng liên quan trong các phép 

thêm, sửa, xóa bản ghi. 

C. Tạo phương tiện giao tiếp giữa người dùng và Access một cách toàn diện nhất. 

D. Tổ hợp dữ liệu từ các bảng và truy vấn để có thể in theo những yêu cầu cụ thể. 



Câu 21: Khi thiết kế Combobox trong Form muốn khai báo độ rộng của các cột 

trong Combobox ta gõ vào thuộc tính nào sau đây trong cửa sổ Properties của 

Combobox? 

A. Column Widths B. List Widths C. Column Width D. List Width 

Câu 22: Vùng DETAIL của REPORTS dùng để làm gì ? 

A. Để in tiêu đề 

B. Dùng để chèn các trường của bảng và Query 

C. Để tạo tiêu đề trên 

D. Để tạo tiêu đề dưới 

Câu 23: Nếu thêm nhầm một bảng làm dữ liệu nguồn trong khi tạo mẫu hỏi, để bỏ 

bảng đó khỏi cửa sổ thiết kế, ta thực hiện: 

A. Tất cả đều sai. B. Edit => Delete. 

C. Query => Remove Table. D. Query => Delete Table. 

Câu 24: Để tạo tính toàn vẹn tham chiếu cho các quan hệ, trước hết ta chọn mục: 

A. Cascade Update Related Fields. B. Cascade Delete Related Fields. 

C. Relationship Type Fields. D. Enforce Referential Integnty. 

Câu 25: Sau khi tạo ra một thủ tục trong lập trình, nếu muốn đặt thủ tục nay đáp ứng 

một sự kiện nào đó cho nút command thì chọn nhóm thuộc tính nào: 

A. Data B. Event C. Format D. Other 

Câu 26: Khi muốn thiết lập liên kết giữa hai bảng thì mỗi bảng phải có: 

A. Số bản ghi bằng nhau. B. Khóa chính giống nhau. 

C. Tất cả đều sai. D. Số trường bằng nhau. 

Câu 27: Khi hai (hoặc nhiều hơn) các điều kiện được kết nối bằng AND hoặc OR, 

kết quả được gọi là: 

A. Tiêu chuẩn kí tự. B. Tiêu chuẩn phức hợp. 

C. Tiêu chuẩn mẫu. D. Tiêu chuẩn đơn giản. 



Câu 28: Để đánh số thứ tự tự động theo nhóm trong Report người ta gõ vào thuộc 

tính Control Source của Textbox là =1. Sau đó vào thuộc tính Running Sum của 

Textbox chọn? 

A. Group Overs B. Over Groups C. Over Group D. Group Over 

Câu 29: Để kiểm tra sự hợp lệ của dữ liệu nhập vào, trong thuộc tính ValidationRule 

ta đặt một biểu thức (điều kiện): Like “K???” có nghĩa là: 

A. Phải nhập 4 ký tự và ký tự đầu phải là K. 

B. Phải nhập ký tự đầu là chuỗi, các ký tự sau là số. 

C. Dữ liệu nhập vào là ký tự bất kỳ nhưng không quá 4 ký tự. 

D. Phải nhập ký tự đầu là chuỗi, các ký tự sau là bất kỳ. 

Câu 30: Trong Query tại vùng QBE (vùng thiết kế Query), để có thể phóng to ô lập biểu 

thức bằng cách ẩn: 

A. Chọn Zoom trên thanh công cụ chuẩn. B. Ctrl+F2. 

C. Shift+F2. D. Alt+F2. 

Câu 31: Quan hệ giữa hai bảng được tạo ra khi: 

A. Số lượng các trường giữa hai bảng phải tương ứng nhau. 

B. Dữ liệu giữa hai bảng này phải tương ứng cùng tên, cùng kiểu. 

C. Khóa chính của bảng này với một trường nào đó của bảng khác, hai trường này 

phải cùng tên, cùng kiểu. 

D. Khóa chính được tạo ra từ bảng của tệp dữ liệu này với một trường nào đó của 

bảng tệp dữ liệu khác có cùng tên, cùng kiểu. 

Câu 32: Để hiển thị một số bản ghi nào đó trong cơ sở dữ liệu, dùng: 

A. Liệt kê. B. Mẫu hỏi. C. Câu hỏi. D. Trả lời. 

Câu 33: Trong cửa sổ thiết kế Query, giả sử Query có trường NGAYSINH, ta muốn 

truy vấn những người sinh năm 1975, tại dòng Criteria của cột NGAYSINH ta gõ: 

A. Between #01/01/1975# and #31/12/1975# 

B. Year([NGAYSSINH]) = 1975 

C. Các câu trên đều đúng 



D. >= #01/01/1975# and <= #31/12/1975# 

Câu 34: Hàm Page() Trong Report dùng để làm gì? 

A. Không dùng để làm gì cả 

B. Tổng số trang trong một bản báo cáo 

C. Điền số thứ tự trang trong một bản báo cáo 

D. Để lấy ngày tháng trong hệ thống 

Câu 35: Điều kiện để tạo mối liên kết giữa hai bảng là: 

A. Trường liên kết của hai bảng phải là chữ hoa 

B. Trường liên kết của hai bảng phải là kiểu dữ liệu số 

C. Trường liên kết của hai bảng phải khác nhau về kiểu dữ liệu liệu 

D. Trường liên kết của hai bảng phải cùng kiểu dữ liệu 

Câu 36: Muốn tạo nhóm trong Report ta làm thế nào? 

A. View\ Sorting and Grouping B. Insert\ Sorting and Grouping 

C. Insert\ Grouping D. View\ Grouping 

Câu 37: Phần nào của báo cáo được in một lần duy nhất khi in báo cáo có 5 trang? 

A. Report header (đầu báo cáo). B. Header (đầu trang). 

C. Footer (chân trang). D. Tất cả đều đúng. 

Câu 38: Phần nào của báo cáo được in ở đầu mỗi trang? 

A. Report footer (chân báo cáo) B. Report header (đầu báo cáo) 

C. Footer (chân trang) D. Header (đầu trang) 

Câu 39: Trong cửa sổ thiết kế Query, để hiện hay ẩn 1 cột khi chạy Query ta phải 

sử dụng dòng nào sau đây? 

A. Criteria B. Sort C. Total D. Show 

Câu 40: Khi thực hiện truy vấn cần nhiều lần với mỗi lần nhập một giá trị khác nhau 

ta sử dụng loại Query nào dưới đây: 



A. Parameter Query. B. Select Query. C. Append Query. D. Delete 

Query. 

Câu 41: Hãy điền vào chỗ trống (...) trong các câu sau để được khẳng định đúng: 

A. ...Mẫu hỏi.............................. là câu hỏi về thông tin trong các bảng được biểu 

diễn dưới dạng sao cho Access hiểu được. 

B. COUNT, SUM, AVG, MAX, MIN là các ......hàm................. dựng sẵn của 

Access. 

C. Để tìm các bản ghi trong hai bảng có cùng các giá trị tại các trường tương 

ứng, trước tiên cần liên kết............................ các hàng. 

D. Việc tạo nhóm các bản ghi có cùng các đặc điểm chung được gọi là 

..............................gộp nhóm 

E. Trong một mẫu hỏi, để ......điều kiện tìm kiếm.............................. đúng thì mỗi 

điều kiện thành phần phải đúng. 

F. Nửa dưới của cửa sổ Query Design chứa lưới QBE................................, nơi 

người dùng chọn các trường đưa vào ...mẫu hỏi................................, thứ tự sắp xếp 

và xác định điều kiện. 

 

Câu 42: Hãy đánh dấu ✓ thích hợp vào ô tương ứng của cột Đúng/Sai: 

Thông tin Đúng Sai 

Trên hàng Field cần có tất cả các trường trong các bảng liên quan 

đến mẫu hỏi 

  

Ngầm định, các trường đưa vào mẫu hỏi đều được hiển thị   



Avg, Min, Max, Count là các hàm tổng hợp dữ liệu   

Thứ tự sắp xếp cần được chỉ ra trên hàng Sort   

Mỗi trường trên hàng Field chỉ xuất hiện đúng một lần   

Không thể thay đổi thứ tự các trường trong mẫu hỏi   

 



ÔN TẬP CHƯƠNG 2 

 

Câu 1: Nhóm HS nói về biểu mẫu (Form) 

+ HS1: Có thể tạo cấu trúc bảng trong biểu mẫu. 

+ HS2: Có thể tạo nút lệnh để thực hiện thao tác nào đó. 

+ HS3: ChỈ hiển thị được thông tin của bản ghi đầu tiên. 

+ HS4: Hiển thị dữ liệu dưới dạng thuận tiện để xem, sửa, nhập. 

Những học sinh nào nói đúng? 

A. HS1, HS2 B. HS2, HS4 C. HS2, HS3 D. HS1, HS4 

Câu 2: Câu nào đúng trong các câu dưới đây, khi nói về khả năng của mẫu hỏi. 

A. Thực hiện tính toán như tính trung bình cộng, tính tổng, đếm bản ghi, … 

B. Chọn các trường để hiển thị. 

C. Chọn các bản ghi thỏa mãn các điều kiện cho trước. 

D. Cả 3 câu đều đúng. 

Câu 3: Câu nào đúng trong các câu dưới đây, khi nói về khả năng của mẫu hỏi. 

A. Tổng hợp và hiển thị thông tin từ nhiều bảng hoặc mẫu hỏi khác. 

B. Cả 3 câu đều đúng. 

C. Sửa cấu trúc của các bảng một cách nhanh chóng. 

D. Cập nhật dữ liệu nhanh. 

Câu 4: Em hãy cho biết các biểu thức dưới đây, biểu thức nào đúng? 

A. [Tuoi] >= “18” or [DoiTuong] = “Ưu tiên” 

B. Luong: [HeSo] * [BacLuong] + “PhuCap” 

C. TienTra: ([ChiSoCuoi] – [ChiSoDau]) * DonGia 

D. Between 1/1/1970 and 31/12/1990 

Câu 5: Câu nào sai trong các câu dưới đây? 



A. Không thể sửa đổi được biểu mẫu sau khi tạo mẫu biểu bằng thuật sĩ (Create 

form by using wizard). 

B. Nhấn và giữ phím Shift kết hợp với kích chọn đối tượng để chọn được nhiều 

đối tượng trong biểu mẫu. 

C. Có thể tự thiết kế mẫu biểu bằng cách nháy đúp Create form in Design View. 

D. Việc nhập dữ liệu trong biểu mẫu thực chất là cập nhật dữ liệu trên bảng dữ 

liệu nguồn. 

Câu 6: Trong các tên trường được đặt dưới đây, tên nào đúng? 

A. LOP 12A B. @MAIL C. MAHS# D. %TYLE 

Câu 7: Câu nào đúng trong các câu dưới đây? 

A. Tên trường là một dãy không quá 256 kí tự, bao gồm chữ cái, chữ số, khoảng 

trắng. 

B. Tên trường là một dãy không quá 128 kí tự, không bao gồm chữ cái, chữ số, 

khoảng trắng. 

C. Tên trường là một dãy không quá 64 kí tự, bao gồm chữ cái, chữ số, khoảng 

trắng. 

D. Tên trường là một dãy không quá 128 kí tự, bao gồm chữ cái, chữ số, khoảng 

trắng. 

Câu 8: Câu nào đúng trong các câu sau? 

A. Có thể chọn phông chữ cho dữ liệu của bảng trong trang dữ liệu bằng cách 

chọn lệnh Format → Font. 

B. Trong Microsoft Access không hiển thị dữ liệu từ nhiều bảng. 

C. Trong chế độ trang dữ liệu của bảng không thể thay đổi độ rộng của cột và 

chiều cao của dòng. 

D. Microsoft Access không thể in bảng chứa kết quả lọc. 

Câu 9: Nhóm học sinh nói về cách thiết lập liên kết giữa các bảng. 

+ HS1: Chọn Tools => Relationships, sau đó chọn trường liên quan từ các bảng 

liên kết, rồi nháy Create để tạo. 



+ HS2: Nháy vào nút lệnh , sau đó chọn trường liên quan từ các bảng liên kết, 

rồi nháy Create để tạo. 

+ HS3: Nháy vào nút lệnh , sau đó chọn trường liên quan từ các bảng liên kết, 

rồi nháy Create để tạo. 

+ HS4: Chọn Insert => Relationships, sau đó chọn trường liên quan từ các bảng 

liên kết, rồi nháy Create để tạo. 

Học sinh nào có cách thiết lập liên kết giữa các bảng đúng? 

A. HS2 và HS3 B. HS1 và HS2 C. HS3 và HS4 D. HS1 và HS3 

Câu 10: Em hãy cho biết các biểu thức dưới đây, biểu thức nào đúng? 

A. Luong: [HeSo] * [BacLuong] + “PhuCap” 

B. Cả 3 câu đều đúng. 

C. Between 1/1/1970 and 31/12/1990 

D. [DoiTuong] = “Ưu tiên” and [XepLoai] = “Giỏi” 

Câu 11: Khi nhập dữ liệu, nếu dữ liệu của trường lặp đi lặp lại nhiều lần, để đặt giá 

trị mặc định cho trường em thực hiện? 

A. Chọn trường cần đặt giá trị mặc định, chọn thuộc tính caption và nhập giá trị 

mặc định. 

B. Chọn trường cần đặt giá trị mặc định, chọn thuộc tính Validation Rule và 

nhập giá trị mặc định. 

C. Chọn trường cần đặt giá trị mặc định, chọn thuộc tính Default Value và nhập 

giá trị mặc định. 

D. Chọn trường cần đặt giá trị mặc định, chọn thuộc tính Input Mask và nhập giá 

trị mặc định. 

Câu 12: Em hãy cho biết biểu thức nào dưới đây đúng khi xếp loại (XLoai) học lực 

của từng học sinh, nếu DTB>=8 xếp loại “Giỏi”, 7<=DTB<8 xếp loại “Khá”, 

5<=DTB<7 xếp loại “Trung Bình”, DTB<5 xếp loại “Yếu”. 

A. XLoai: IIf([DTB]>=8, ‘Giỏi’, IIf([DTB]>=7, ‘Khá’, IIf([DTB] >=5, ‘Trung 

Bình’, ‘Yếu’))). 



B. XLoai: IIf([DTB]>=8, “Giỏi”, IIf([DTB]>=7,“Khá”, IIf([DTB] >=5,“Trung 

Bình”,“Yếu”))). 

C. XLoai: If([DTB]>=8, ‘Giỏi’, If([DTB]>=7, ‘Khá’, If([DTB] >=5, ‘Trung 

Bình’, ‘Yếu’))). 

D. XLoai: If([DTB]>=8, “Giỏi”, If([DTB]>=7, “Khá”, If([DTB] >=5, “Trung 

Bình”, “Yếu”))). 

Câu 13: Trong các tên trường được đặt dưới đây, tên nào sai? 

A. NOI_SINH B. DIEML1 C. [TONGDIEM] D. LOP 12A 

Câu 14: Khi mở một báo cáo, nó được hiển thị dưới dạng nào? 

A. Chế độ xem trước. B. Chế độ biểu mẫu. 

C. Chế độ thiết kế. D. Chế độ trang dữ liệu. 

Câu 15: Câu nào sai trong các câu dưới đây? 

A. Microsoft Access có khả năng tạo mẫu biểu để cập nhật dữ liệu, tạo báo cáo 

thống kê, khai thác dữ liệu trong CSDL. 

B. Microsoft Access là hệ quản trị cơ sở dữ liệu nằm trong bộ phần mềm của 

Microsoft Office. 

C. Microsoft Access có khả năng tạo lập CSDL và lưu trữ chúng trên các thiết bị 

nhớ. 

D. Microsoft Access có khả năng đáp ứng tất cả các yêu cầu của người dùng. 

Câu 16: Những khả năng dưới đây, khả năng nào không phải là khả năng của báo 

cáo. 

A. Sắp xếp dữ liệu trước khi in. 

B. Dễ dàng thiết kế và chỉnh sửa cấu trúc của bảng. 

C. In dữ liệu dưới dạng bảng, dạng biểu. 

D. Sắp xếp và phân nhóm dữ liệu. Thực hiện các phép tính để có dữ liệu tổng 

hợp trên các nhóm. 

Câu 17: Câu nào sai trong các câu dưới đây? 



A. Không có cách nào khác để có thể chuyển đổi qua lại giữa chế độ thiết kế và 

chế độ trang dữ liệu bằng cách nháy nút hay nút lệnh. 

B. Thuật sĩ là chương trình hướng dẫn từng bước giúp tạo được các đối tượng 

của CSDL từ các biểu mẫu dựng sẵn. 

C. Có 2 chế độ làm việc với các đối tượng đó là chế độ thiết kế và chế độ trang 

dữ liệu. 

D. Trong Microsoft Access, mỗi đối tượng có thể được tạo bằng nhiều cách khác 

nhau. 

Câu 18: Câu nào sai trong các câu dưới đây? Trong chế độ thiết kế mẫu hỏi: 

A. Hàng Table thể hiện tên bảng chứa trường tương ứng. 

B. Hàng Field dùng để khai báo các trường được lựa chọn. 

C. Hàng Sort để xác định (các) trường cần sắp xếp. 

D. Hàng Criteria để xác định (các) trường xuất hiện trong mẫu hỏi. 

Câu 19: Khái niệm nào đúng trong các câu dưới đây? 

A. Bảng là thành phần cơ sở tạo nên CSDL, các bảng chứa toàn bộ dữ liệu mà 

người dùng cần để khai thác. 

B. Mỗi trường là một hàng của bảng thể hiện mọi thuộc tính của chủ thể cần 

quản lý. 

C. Mỗi bản ghi là một cột của bảng gồm dữ liệu về các thuộc tính của chủ thể 

được quản lý. 

D. Kiểu dữ liệu là kiểu của dữ liệu lưu trong một trường. Mỗi trường có thể có 

nhiều kiểu dữ liệu. 

Câu 20: Cấu trúc bảng được xác định bởi: 

A. Các trường và thuộc tính của nó. 

B. Các thuộc tính của đối tượng cần quản lí. 

C. Thuộc tính của bảng. 

D. Các bản ghi dữ liệu. 



Câu 21: Khi tạo CSDL, nhóm học sinh nói về việc có nên lưu trữ thông tin cần quản 

lý vào một bảng hay nhiều bảng? 

+ HS1: Lưu trữ thông tin vào nhiều bảng, đảm bảo tính không dư thừa và nhất 

quán của dữ liệu. 

+ HS2: Lưu thông tin vào một bảng, tìm kiếm thông tin nhanh hơn. 

+ HS3: Lưu thông tin vào một bảng, đảm bảo tính an toàn và bảo mật thông tin. 

+ HS4: Lưu trữ thông tin vào nhiều bảng, khi cần lấy thông tin phải liên kết giữa 

các bảng. 

Những học sinh nào nói đúng? 

A. HS1, HS2 B. HS3, HS4 C. HS2, HS4 D. HS1, HS4 

Câu 22: Câu nào sai trong các câu dưới đây? 

A. Có thể đặt màu nền, màu chữ, màu viền cho các điều khiển. 

B. Có thể làm cho các điều khiển có dạng nổi, chìm. 

C. Có thể lấy hình ảnh để làm nền cho biểu mẫu. 

D. Chế độ biểu mẫu không cho phép thực hiện thao tác tìm kiếm, lọc, sắp xếp 

thông tin. 

Câu 23: Giả sử khi nhập ngày vào làm việc cho cán bộ, muốn hiển thị dữ liệu theo 

mẫu 23/09/72 thì em phải chọn kiểu dữ liệu là Date/Time, thuộc tính Format là: 

A. Medium Date. B. Long Data. C. Short Date. D. General. 

Câu 24: Dữ liệu được lưu ở: 

A. Các bảng. B. Các biểu mẫu. C. Các báo cáo. D. Mẫu hỏi. 

Câu 25: Câu nào sai trong các câu dưới đây: 

A. Để thêm trường vào bên trên trường hiện tại, vào Insert → Row sau đó gõ tên 

trường, chọn kiểu dữ liệu, mô tả và xác định các tính chất của trường nếu có. 

B. Để đổi tên cho bảng, lựa chọn bảng sau đó chọn lệnh Edit → Rename, nhập 

tên mới cho bảng rồi nhấn Enter. 

C. Sau khi tạo bảng xong, không thể thay đổi cấu trúc của bảng. 

D. Để xóa một trường ta lựa chọn trường cần xóa, chọn Edit → Delete Row. 



Câu 26: Trong các tên trường được đặt dưới đây, tên nào sai? 

A. Họ Và Tên B. NOI_SINH C. HO&TEN D. 

NGAYSINH 

Câu 27: Nhóm học sinh nói về cách sắp xếp dữ liệu trong bảng chế độ hiển thị trang 

dữ liệu  

HS1: Chọn tên trường cần sắp xếp, vào Records → Sort, chọn Sort Ascending các 

bản ghi sẽ được sắp xếp theo thứ tự tăng dần. 

HS2: Chọn tên trường cần sắp xếp, vào Records → Sort, chọn Sort Descending 

các bản ghi sẽ được sắp xếp theo thứ tự tăng dần. 

HS3: Chọn tên trường cần sắp xếp, nhấn vào nút  , các bản ghi sẽ được sắp xếp 

theo thứ tự giảm dần. 

HS4: Chọn tên trường cần sắp xếp, nhấn vào nút  , các bản ghi sẽ được sắp 

xếp theo thứ tự giảm dần. 

Học sinh nào có cách làm đúng? 

A. HS3 và HS4. B. HS1 và HS4. C. HS2 và HS3. D. HS1 và 

HS2. 

Câu 28: Hãy cho biết nút lệnh nào dưới đây dùng để chỉnh sửa biểu mẫu: 

A. . B. . C. . D. . 

Câu 29: Hãy cho biết nút lệnh nào dưới đây dùng để tạo bảng mới: 

A. . B. . C. . D. . 

Câu 30: Không thể dùng đối tượng nào để cập nhật dữ liệu? 

A. Biểu mẫu. B. Mẫu hỏi. C. Bảng. D. Báo cáo. 

Câu 31: Để tránh bị mất tệp CSDL mỗi khi cài đặt lại Microsoft Access em không 

nên? 

A. Lưu tệp CSDL vào trong thư mục Microsoft Access. 

B. Lưu vào ổ đĩa D 

C. Xây dựng một thư mục mới chứa CSDL cần tạo. 



D. Lưu vào ổ đĩa chứa thư mục Microsoft Access. 

Câu 32: Bảng cán bộ (CANBO) có trường năm công tác (NCT) lưu trữ ngày bắt đầu 

vào làm việc của các cán bộ. Để biết được số năm công tác (SoNam) của từng cán 

bộ ta phải viết biểu thức nào dưới đây? 

A. SoNam: Date() – [NCT] 

B. SoNam: Now() – [NCT] 

C. SoNam: int ( ( Date() - [NCT] ) / 365, 1 ) 

D. SoNam: int ( ( Date() - [NCT]) / 365 ) 

Câu 33: Giả sử có mẫu hỏi chứa các Trường: HoTen (họ và tên), NgaySinh (ngày 

sinh), NoiSinh (Nơi sinh), GioiTinh (giới tính). Để hiển thị những người có giới tính 

là Nữ và ngày sinh trùng với ngày 8/3, em phải nhập điều kiện nào dưới đây vào 

dòng Criteria của trường GioiTinh và NgaySinh. 

A. Đưa điều kiện “Nữ” vào trường GioiTinh và 8/3 vào trường NgaySinh. 

B. Đưa điều kiện “Nữ” vào trường GioiTinh và “8/3/*” vào trường NgaySinh. 

C. Đưa điều kiện “Nữ” vào trường GioiTinh và #8/3/*# vào trường NgaySinh. 

D. Đưa điều kiện “Nữ” vào trường GioiTinh và Like “8/3/*” vào trường 

NgaySinh. 

Câu 34: Chọn câu sai trong các câu dưới đây: 

A. Muốn tạo khóa chính cho bảng, chọn trường làm khóa chính sau đó nháy nút 

   (Primary Key). 

B. Một CSDL có thiết kế tốt là CSDL mà mỗi bản ghi trong một bảng phải duy 

nhất. 

C. Trường đã được chỉ định làm khóa chính thì không thể thay thế được. 

D. Muốn tạo khóa chính cho bảng, chọn trường làm khóa chính sau đó chọn 

lệnh Edit → Primary Key. 

Câu 35: Khi cần in dữ liệu từ một CSDL theo một mẫu cho trước, cần sử dụng       đối 

tượng nào? 

A. Mẫu hỏi. B. Bảng. C. Biểu mẫu. D. Báo cáo. 



Câu 36: Câu nào đúng khi nói về mẫu hỏi? 

A. Là đối tượng duy nhất trong Microsoft Access có thể kết xuất thông tin từ 

nhiều bảng. 

B. Là đối tượng có thể lọc ra các bản ghi thỏa mãn điều kiện. 

C. Là đối tượng có thể được tạo bởi nhiều cách nhất. 

D. Là đối tượng không thay đổi được sau khi thiết kế. 

Câu 37: Báo cáo có ưu điểm gì so với các đối tượng khác 

A. Tổng hợp dữ liệu được từ nhiều bảng 

B. Trình bày được nội dung theo mẫu văn bản qui định 

C. Có thể định dạng và in văn bản 

D. Sắp xếp dữ liệu nhanh 

Câu 38: Những khả năng dưới đây, khả năng nào không phải là khả năng của báo 

biểu. 

A. In dữ liệu dưới dạng bảng, dạng biểu. 

B. Sắp xếp dữ liệu trước khi in. 

C. Lọc ra các bản ghi thỏa mãn điều kiện. 

D. In dữ liệu từ nhiều bảng, truy vấn có liên quan trên cùng một báo cáo. 

Câu 39: Thành phần nào trong các thành phần dưới đây có trong báo biểu mà không 

có trong mẫu biểu. 

A. Phần đầu (Header) B. Đầu nhóm 

C. Đầu trang (Page Header) D. Phần thân (Detail) 

Câu 40: Thành phần nào trong các thành phần dưới đây có trong báo biểu mà không 

có trong mẫu biểu. 

A. Đầu trang (Page Header) B. Cuối nhóm 

C. Cuối trang (Page Header) D. Phần cuối (Footer) 

Câu 41: Báo biểu có bao nhiêu chế độ hiển thị 

A. 1 B. 2 C. 3 D. 4 



Câu 42: Hãy chọn thứ tự các bước dưới đây để tạo được báo cáo bằng thuật sĩ. 

B1: Chọn bảng, mẫu hỏi chứa dữ liệu nguồn sau đó chọn trường đưa vào báo cáo 

trong hộp thoại Report Wizard. 

B2: Đặt tiêu đề cho báo cáo. 

B3: Xem báo cáo trước khi in và chỉnh sửa báo cáo (nếu cần). 

B4: Chọn trường để gộp nhóm. 

B5: Chọn cách bố trí các bản ghi và các trường trên báo cáo. 

B6: Chọn trường để sắp xếp thứ tự các bản ghi  

B7: Chọn đối tượng Reports. 

B8: Nháy đúp chuột vào mục Create Report By Using Wizard. 

Chọn thứ tự đúng. 

A. B1 – B2 – B3 – B4 – B5 – B6 – B7 – B8 

B. B8 – B1 – B2 – B7 – B3 – B6 – B4 – B5 

C. B7 – B8 – B1 – B4 – B6 – B5 – B2 – B3 

D. B5 – B6 – B4 – B3 – B1 – B2 – B7 – B8 

Câu 43: Giả sử trường DiaChi trong bảng NHANVIEN được khai báo kiểu Text, 

phần thuộc tính Field Size được nhập là 30. Điều này có nghĩa là: 

A. Chỉ có thể nhập dữ liệu tối đa cho trường là 30 kí tự. 

B. Có thể nhập dữ liệu có trường 30 kí tự không kể kí tự số. 

C. Phải nhập dữ liệu cho trường đủ 30 kí tự. 

D. Phải nhập dữ liệu tối thiểu cho trường là 30 kí tự. 

Câu 44: Câu nào trong các câu dưới đây sai? Để chuyển đổi giữa các chế độ hiển 

thị khi thiết kế báo cáo 

A. Vào File chọn Print Preview để xem thử và kiểm tra toàn bộ nội dung, các trình 

bày của báo cáo trước khi in. 

B. Vào File chọn Layout Preview để xem thử kết quả của báo biểu. 

C. Vào View chọn Layout Preview để xem thử kết quả của báo biểu. 



D. Vào View chọn Design View để chỉnh sửa lại thiết kế của báo biểu. 

Câu 45: Cách nào trong các cách dưới đây sai khi muốn xem kết quả của mẫu hỏi 

khi đang ở chế độ thiết kế. 

A. Nhấn chuột vào nút lệnh B. Chọn lệnh View => Design View 

C. Chọn lệnh View => Datasheet View D. Câu A và câu C đúng 



ÔN TẬP HKI 
 

Câu 1: Nên lập mối quan hệ trước hay sau khi nhập dữ liệu cho bảng. 

A. Trước sau cũng được B. Trước 

C. Các câu trên đều sai. D. Sau 

Câu 2: Hai trường có nội dung là  “ngày sinh” và “đoàn viên” có kiểu dữ liệu lần 

lượt là 

A. Number và Yes/No B. Date/Time và Yes/No 

C. Number và Text D. Text và Number 

Câu 3: Tên cột (tên trường) được viết bằng chữ hoa hay chữ thường 

A. Bắt buộc phải viết thường. 

B. Không phân biệt chữ hoa hay chữ thường. 

C. Bắt buộc phải viết hoa. 

D. Tùy theo trường hợp. 

Câu 4: Khi làm việc với cấu trúc bảng, để xác định kiểu dữ liệu của trường ta xác 

định tại cột: 

A. Data Type B. Descriptions C. Field Type. D. File properties 

Câu 5: Cơ sở dữ liệu là tập hợp dữ liệu có liên quan với nhau, và được lưu trữ trên: 

A. CPU B. RAM 

C. ROM D. Thiết bị nhớ ngoài 

Câu 6: Khi chọn dữ liệu cho các trường chỉ chứa một trong hai giá trị như GioiTinh, 

trường Đơn đặt hàng đã hoặc chưa giải quyết … nên chọn kiểu dữ liệu để sau này 

nhập dữ liệu cho nhanh. 

A. Number B. Text C. Yes/No D. Auto Number 

Câu 7: Trong Microsoft Access, các đối tượng (Objects) có mấy chế độ làm việc? 

A. 2 B. 4 C. 1 D. 3 

Câu 8: Để tạo liên kết giữa hai bảng cần: 



A. Trường liên kết của hai bảng là chữ hoa. 

B. Trường liên kết của hai bảng phải cùng kiểu dữ liệu. 

C. Trường liên kết của hai bảng phải khác nhau về kiểu dữ liệu. 

D. Trường liên kết của hai bảng là kiểu dữ liệu số. 

Câu 9: Hãy chọn nhận định sai về các khái niệm trong cấu trúc bảng. 

A. Bảng là thành phần cơ sở tạo nên CSDL. 

B. Mỗi trường có 1 kiểu dữ liệu. 

C. Bản ghi (Record) gồm dữ liệu về chủ thể được quản lý. 

D. Trường (Field) là một dòng của bảng. 

Câu 10: Chọn nhận định đúng về khoá chính: 

A. Không thể thay đổi thuộc tính khoá chính cho trường khác nếu đặt nhầm. 

B. Tránh trường hợp thông tin về 1 cá thể xuất hiện hơn một lần khi cập nhật dữ 

liệu. 

C. Khoá chính nhằm đảm bảo tính không dư thừa cho hệ CSDL. 

D. Một bảng chỉ có thể có 1 khoá chính cho 1 trường duy nhất 

Câu 11: Phần đuôi của tên tập tin trong Microsoft Access là 

A. ODT B. OBD C. MDB D. OTD 

Câu 12: Muốn xóa liên kết giữa hai bảng, trong cửa sổ Relationships ta thực hiện: 

A. Chọn tất cả các bảng và nhấn phím Delete. 

B. Tất cả đều sai. 

C. Chọn hai bảng và nhấn phím Delete. 

D. Chọn đường liên kết giữa hai bảng đó và nhấn phím Delete. 

Câu 13: Khi tạo ra một biểu mẫu để nhập dữ liệu thì ta bắc buộc phải: 

A. chọn bố cục cho biểu mẫu  

B. nhập tên cho biểu mẫu. 

C. xác định dữ liệu nguồn (record source).  



D. xác định hành động cho biểu mẫu đó. 

Câu 14: Chọn đáp án đúng nhất: 

A. Khóa chính có thể đặt tùy ý 

B. Khóa chính dùng để xác định giá trị duy nhất của dữ liệu. 

C. Dữ liệu trong bảng có thể nhập tùy ý. 

D. Khi thiết kế bảng không cần đặt khóa chính vì máy đã ngầm định cho trường 

đầu tiên trong CSDL làm khóa chính. 

Câu 15: Trong vai trò của con người khi làm việc với các hệ cơ sở dữ liệu, người 

thiết kế và cấp phát quyền truy cập cơ sở dữ liệu, là người? 

A. Người quản trị cơ sở dữ liệu. 

B. Người dùng. 

C. Người bảo trì các phần cứng của máy tính. 

D. Người lập trình ứng dụng. 

Câu 16: Người làm việc  với hệ CSDL có thể có mấy vai trò? 

A. 3. B. 4. C. 2. D. 5. 

Câu 17: Một CSDL là tập hợp các dữ liệu có liên quan với nhau, chứa thông tin của 

một tổ chức nào đó, được lưu trữ trên các thiết bị nhớ nhằm đáp ứng nhu cầu khai 

thác thông tin… 

A. …của một người dùng với mục đích riêng. 

B. …của một người dùng với nhiều mục đích khác nhau. 

C. …của nhiều người dùng với nhiều mục đích khác nhau. 

D. …của nhiều người dùng với có cùng mục đích giống nhau. 

Câu 18: Độ rộng của trường có thể thay đổi ở đâu: 

A. Không thể thay đổi được. B. Trong chế độ trang dữ liệu. 

C. Tất cả đều sai. D. Trong chế độ thiết kế. 

Câu 19: Sắp xếp các bước theo đúng thứ tự thực hiện để tạo liên kết giữa hai bảng: 



1. Kéo thả trường khóa làm liên kết từ bảng phụ tới bảng chính (trường khóa làm 

khóa chính); 

2. Xác nhận kiểu quan hệ; 

3. Hiển thị hai bảng (các trường) muốn tạo liên kết; 

4. Mở cửa sổ Relationships. 

A. 4, 3, 1, 2 B. 2, 3, 1, 4 C. 1, 2, 3, 4 D. Tất cả đều sai. 

Câu 20: Trong CSDL quản lí học sinh, có thể tìm các học sinh là nam và có điểm 

trung bình môn Tin từ 8,5 trở lên bằng biểu thức lọc: 

A. [GT] = “Nam” OR [Tin] >= 8.5  

B. (GT) = “Nam” OR (Tin) >= 8.5 

C. (GT) = “Nam” AND (Tin) >= 8.5  

D. [GT] = “Nam” AND [Tin] >= 8.5 

Câu 21: Hệ quản trị CSDL là 

A. Phần mềm để thao tác và xử lý các đối tượng trong CSDL 

B. Phần mềm dùng tạo lập CSDL 

C. Phần mềm dùng tạo lập, lưu trữ một CSDL 

D. Phần mềm dùng tạo lập, lưu trữ và khai thác một CSDL 

Câu 22: Người nào đã tạo ra các phần mềm ứng dụng đáp ứng nhu cầu khai thác 

thông tin từ CSDL 

A. Cả ba người B. Người lập trình ứng dụng 

C. Người dùng cuối D. Người QTCSDL 

Câu 23: Bảng đã được hiển thị ở chế độ thiết kế muốn thêm một trường vào bên trên 

trường hiện tại, thao tác thực hiện lệnh nào sau đây là đúng: 

A. File/Save/<Tên tệp> B. Insert/New Record. 

C. Insert/NewRows D. Create Table by Using Wizard 

Câu 24: Tạo liên kết giữa các bảng để làm gì? 

A. In dữ liệu theo khuôn dạng B. Để xem, sửa và nhập dữ liệu 



C. Tổng hợp dữ liệu từ nhiều bảng D. Nhập thông tin dễ dàng 

Câu 25: H·y chän c¸ch viÕt ®óng? 

A. TIEN_LAI # [TIEN_GUI] * [MUC_LAI]  

B. TIEN_LAI:= [TIEN_GUI] * [MUC_LAI] 

C. TIEN_LAI: [TIEN_GUI] * [MUC_LAI]  

D. TIEN_LAI = [TIEN_GUI] * [MUC_LAI] 

Câu 26: Trong của sổ CSDL đang làm việc, để tạo mẫu hỏi bằng cách dùng thuật sĩ, 

thao tác thực hiện lệnh nào sau đây là đúng 

A. Tables/Create Table in Design View  

B. Queries/ Use Wizard to create queries 

C. Queries/Create Queries in Wizard  

D. Tables/Create Tables by Using Wizard 

Câu 27: Các thành phần của hệ CSDL gồm 

A. CSDL, hệ QTCSDL 

B. Con người, phần mềm ứng dụng, hệ QTCSDL, CSDL 

C. Con người, CSDL, phần mềm ứng dụng 

D. CSDL, hệ QTCSDL, con người 

Câu 28: Trong Microsoft Access, cã nh÷ng lo¹i biÓu thøc nµo 

A. BiÓu thøc sè häc, biÓu thøc ®iÒu kiÖn 

B. BiÓu thøc sè häc, biÓu thøc l«gic 

C. BiÓu thøc sè häc, biÓu thøc ®iÒu kiÖn, biÓu thøc l«gic 

D. BiÓu thøc l«gic, biÓu thøc ®iÒu kiÖn 

Câu 29: Truy vấn dữ liệu có nghĩa là: 

A. Xóa các dữ liệu không cần đến nữa B. In dữ liệu 

C. Tìm kiếm và hiển thị dữ liệu D. Cập nhật dữ liệu 



Câu 30: Khi tạo mẫu hỏi thì chức năng của nút lệnh  là gì? 

A. Thêm hàng Total vào lưới thiết kế B. Mở hộp thoại Add Table 

C. Thêm trường vào cho bảng D. Thực hiện mẫu hỏi 

Câu 31: Cheá ñoä bieåu maãu thích hôïp vôùi: 

A. caû ngöôøi duøng vaø ngöôøi thieát keá; B. taát caû ñeàu sai 

C. ngöôøi duøng; D. ngöôøi thieát keá CSDL; 

Câu 32: Ngôn ngữ định nghĩa dữ liệu cho phép: 

A. Mô tả các đối tượng được lưu trữ trong CSDL 

B. Đảm bảo tính độc lập dữ liệu 

C. Khai báo kiểu, cấu trúc dữ liệu; khai báo các ràng buộc trên dữ liệu 

D. Khai báo kiểu dữ liệu trên CSDL 

Câu 33: Tên của tập tin trong Microsoft Access bắt buộc phải đặt trước hay sau khi 

tạo CSDL 

A. Bắt buộc vào là đặt tên tệp ngay rồi mới tạo CSDL sau. 

B. Đặt tên tệp sau khi đã tạo CSDL. 

Câu 34: Trong Microsoft Access, khi sử dụng các trường làm các toán hạng trong 

các biểu thức, thì tên các trường phải được đặt trong cặp dấu 

A. Ngoặc tròn ( … )  B. Ngoặc nhọn { … }  

C. Ngoặc vuông [ … ] D. Ngoặc kép “ … ” 

Câu 35: Bảng DIEM có các trường MOT_TIET, HOC_KY. Trong Mẫu hỏi, biểu 

thức số học để tạo trường mới TRUNG_BINH, lệnh nào sau đây là đúng: 

A. TRUNG_BINH:(2* [MOT_TIET] + 3*[HOC_KY])/5 

B. TRUNG_BINH:(2* MOT_TIET + 3*HOC_KY)/5 

C. TRUNG_BINH=(2* [MOT_TIET] + 3*[HOC_KY])/5 

D. TRUNG_BINH:(2* [MOT_TIET] + 3*[HOC_KY]):5 

Câu 36: Mỗi đối tượng của Microsoft Access có các chế độ làm việc là: 



A. Trang dữ liệu và thiết kế B. thiết kế và cập nhật 

C. chỉnh sửa và cập nhật D. Thiết kế và bảng 

Câu 37: Sau khi thiết kế xong bảng, nếu ta không chỉ định khóa chính thì: 

A. Tất cả đều đúng. 

B. Microsoft Access không cho phép lưu bảng. 

C. Microsoft Access không cho phép nhập dữ liệu. 

D. Dữ liệu có thể có hai hàng giống hệt nhau. 

Câu 38: Khi muốn thiết lập liên kết giữa hai bảng thì mỗi bảng phải có: 

A. Số trường bằng nhau. B. Số bản ghi bằng nhau. 

C. Khóa chính giống nhau. D. Tất cả đều sai. 

Câu 39: Thành phần chính của hệ QTCSDL: 

A. Bộ xử lý truy vấn và bộ quản lý dữ liệu  

B. Bộ quản lý tập tin và bộ xử lí truy vấn 

C. Bộ truy xuất dữ liệu và bộ quản lý tập tin  

D. Bộ quản lý tập tin và bộ truy xuất dữ liệu 

Câu 40: Câu nào sai trong các câu dưới đây? 

A. Có thể đặt màu nền, màu chữ, màu viền cho các điều khiển. 

B. Có thể lấy hình ảnh để làm nền cho biểu mẫu. 

C. Có thể làm cho các điều khiển có dạng nổi, chìm. 

D. Chế độ biểu mẫu không cho phép thực hiện thao tác tìm kiếm, lọc, sắp xếp 

thông tin. 

Câu 41: Câu nào sai trong các câu dưới đây? 

A. Có thể làm cho các điều khiển có dạng nổi, chìm. 

B. Có thể đặt màu nền, màu chữ, màu viền cho các điều khiển. 

C. Chế độ biểu mẫu không cho phép thực hiện thao tác tìm kiếm, lọc, sắp xếp 

thông tin. 



D. Có thể lấy hình ảnh để làm nền cho biểu mẫu. 

Câu 42: Một hệ CSDL gồm: 

A. CSDL và hệ QTCSDL B. CSDL và các thiết bị vật lí 

C. Hệ QTCSDL và các thiết bị vật lí D. Các phần mềm ứng dụng và CSDL 

Câu 43: Bản ghi của Table chứa những gì 

A. Chứa tên trường B. Chứa độ rộng của trường 

C. Chứa các giá trị của cột D. Chứa tên cột 

Câu 44: Khái niệm nào đúng trong các câu dưới đây? 

A. Bảng là thành phần cơ sở tạo nên CSDL, các bảng chứa toàn bộ dữ liệu mà 

người dùng cần để khai tháC. 

B. Mỗi bản ghi là một cột của bảng gồm dữ liệu về các thuộc tính của chủ thể 

được quản lý. 

C. Kiểu dữ liệu là kiểu của dữ liệu lưu trong một trường. Mỗi trường có 1 kiểu dữ 

liệu. 

D. Mỗi trường là một hàng của bảng thể hiện mọi thuộc tính của chủ thể cần quản 

lý. 

Câu 45: Giả sử có Table NHANVIEN gồm các field: MaNV, MaDonVi, HoTen, 

MucLuong. Để tính BHXH = 5% MucLuong, ta lập field tính toán như sau: 

A. BHXH= 5/100*[MucLuong] B. BHXH: 0.05*[MucLuong] 

C. BHXH= 0.5*[MucLuong] D. BHXH: 0.5*[MucLuong] 

Câu 46: Em hãy cho biết các biểu thức dưới đây, biểu thức nào đúng? 

A. Cả 3 câu đều đúng. 

B. Between 1/1/1970 and 31/12/1990 

C. [DoiTuong] = “Ưu tiên” and [XepLoai] = “Giỏi” 

D. Luong: [HeSo] * [BacLuong] + “PhuCap” 

Câu 47: Với báo cáo, ta không thể làm được việc gì trong những việc sau? 

A. Định dạng kiểu chữ, cỡ chữ cho các tiêu đề và dữ liệu. 



B. Lọc những bản ghi thỏa mãn một điều kiện nào đó. 

C. Bố trí báo cáo và chọn kiểu trình bày. 

D. Lưu báo cáo để sử dụng nhiều lần. 

Câu 48: Giả sử các giá trị của trường MAHH có chiều dài đúng 4 ký tự, 2 ký tự đầu 

là BC. Ta ghi trong Validation Rule như thế nào gọi là hợp lệ? 

A. "LIKE BC??" B. LIKE "BC??" C. "LIKE" BC?? D. "LIKE BC*" 

Câu 49: Tại sao ta nên tạo quan hệ giữa các bảng trước khi nhập dữ liệu 

A. để kiểm tra được sự ràng buộc dữ liệu và không cần nhập lại những thông tin   

đã có 

B. để biết mối liên quan trong khi nhập dữ liệu 

C. vì theo thói quen 

D. do Hệ QT CDSL quy định 

Câu 50: Trong các đối tượng trong Access ta dùng công cụ Wizard để thực hiện chức 

năng? 

A. Tự tính toán một thuật giải B. Tất cả đều sai 

C. Tăng thêm phức tạp lập trình D. Tạo nhanh tự động 

Câu 51: Để có thể thiết lập được mối quan hệ giữa hai bảng thì hai bảng phải có: 

A. giống nhau ở tên khóa chính còn kiểu dữ liệu có thể khác nhau 

B. số trường bằng nhau 

C. khóa chính giống nhau 

D. số bản ghi bằng nhau 

Câu 52: Khi tạo bảng báo cáo có thể sử dụng các hàm và phép toán không? 

A. Không thẻ thể sử dụng các hàm và phép toán. 

B. Chỉ sử dụng các hàm, chứ không sử dụng phép toán. 

C. Chỉ sử dụng các phép toán chứ không sử dụng các hàm. 

D. Có thể sử dụng các hàm và phép toán. 



Câu 53: Tên trường trong tiêu chuẩn  truy vấn được đặt trong hai dấu: 

A. [ ] B. { } C. ( ) D. < > 

Câu 54: Quan hệ dữ liệu giữa các đối tượng? 

A. Table với Query  B. Form với Report  

C. Table với Table  D. Query với Query 

Câu 1: Hãy sắp xếp các bước sau để được một thao tác đúng? (1)-Chọn nút Create 

(2)-Chọn File – New (3)-Nhập tên cơ sở dữ liệu (4)-Chọn Blank DataAccess 

A. (1) -> (2) -> (3) -> (4) B. (1) -> (2) -> (4) -> (3) 

C. (2) -> (4) -> (3) -> (1) D. (2) -> (3) -> (4) -> (1) 

Câu 55: Phần nào của báo cáo được in một lần duy nhất khi in báo cáo có nhiều trang 

A. Footer (chân trang) B. Header (đầu trang) 

C. Report footer (chân báo cáo) D. Report header (đầu báo cáo) 

Câu 56: Các báo cáo lấy thông tin hiển thị từ các đối tượng CDSL nào ? 

A. từ truy vấn và các bảng B. từ các bảng  và Report 

C. từ Form và bảng D. từ Report và bảng 

Câu 57: Kiểu ngày giờ trong tiêu chuẩn truy vấn được đặt trong dấu: 

A. $   $ B. &   & C. #   # D. *   * 

Câu 58: Người ta đánh số trang cho báo cáo ở trong phần: 

A. Header (đầu trang) B. Footer (chân trang) 

C. Report footer (chân báo cáo) D. Report header (đầu báo cáo) 

Câu 59: Sắp xếp các bước sau để được thao tác tạo liên kết giữa hai bảng: 

1. mở cửa sổ relationships 

2. kéo thả trường khóa làm liên kết từ bảng phụ tới bảng chính 

3. hiển thị hai bảng (các trường) muốn tạo liên kết 

4. chọn các tham số liên kết 

A. 1-3-4-2 B. 1-3-2-4 C. 1-4-2-3 D. 2-3-1-4 



Câu 60: Phát biểu nào sau đây sai? 

A. trong Access, dữ liệu được chứa trong tất cả các đối tượng như bảng, truy vấn, 

biểu mẫu, báo cáo,… 

B. giá trị ngầm định của tất cả các trường kiểu number là 0 

C. một bản ghi có thể chứa nhiều trường 

D. độ dài mặc định của trường có kiểu text là 50 

Câu 61: Khi đã tạo một quan hệ giữa hai bảng, nếu muốn sửa đổi quan hệ cần thực 

hiện 

A. Xoá bỏ hoàn toàn cơ sở dữ liệu và tạo lại 

B. Kích phải vào quan hệ muốn sửa đổi và chọn Edit Relation Ships và sửa đổi     

lại dây 

C. Xoá bỏ bảng có quan hệ dã tạo và tạo lại bảng mới 

D. Không thể thay đổi được một quan hệ khi nó đã được tạo ra 

Câu 62: Phát biểu nào sau đây sai? 

A. có thể có các khóa chính giống nhau trong bảng 

B. để xóa bản ghi trong bảng, ta chọn bản ghi và nhấn phím Delete 

C. có thể sử dụng phím tab để di chuyển giữa các ô trong bảng trong chế độ trang 

dữ liệu 

D. chỉ với trường kiểu số thì mới áp dụng các phép toán số học 

Câu 63: Thao tác nào sau đây tạo một Report mới ở chế độ thiết kế? 

A. Từ cửa sổ DataAccess, trong mục Object chọn Query -> New -> Design View 

-> OK. 

B. Từ cửa sổ DataAccess, trong mục Object chọn Report -> Design View -> New 

-> OK. 

C. Từ cửa sổ DataAccess, trong mục Object chọn Report -> New -> Design View 

-> OK. 

D. Từ cửa sổ DataAccess, trong mục Object chọn Query -> Design View -> New 

-> OK. 



Câu 64: Làm sao tránh được giá trị trùng nhau ở một trường không dùng làm khoá 

chính? 

A. Chọn truờng chỉ định, ở thuộc tính Indexed chọn Yes ( Duplicates Ok). 

B. Không thể đượC. 

C. Chọn truờng chỉ định, ở thuộc tính Indexed chọn Yes (No Duplicates). 

D. Các câu trên đều sai. 

Câu 65: Table trong MS Access, có các thành phần cơ bản nào sau đây: 

A. Field name, Record. B. Tên trường, bản ghi dữ liệu. 

C. Tên cột, bản ghi dữ liệu. D. Tất cả đều đúng. 

Câu 66: Muốn tạo trường để chứa hình ảnh, bảng tính, văn bản...khi thiết kế trường 

ta chọn thuộc tính Data Type là: 

A. Hyperlike. B. OLE Object. C. Text. D. Number. 

Câu 67: Nhóm lựa chọn nào sau đây chỉ cho phép chọn duy nhất một giá trị trong 

nhóm:? 

A. Caption. B. Option Button. C. Check Box. D. Toggle Button. 

Câu 68: Khi tiến hành công việc thiết kế bảng, người sử dụng chương trình làm các 

công việc: 

A. Khai báo tên trường, kiểu dữ liệu. 

B. Khai báo tên trường, kiểu dữ liệu, các thuộc tính của trường. 

C. Khai báo tên trường. 

D. Khai báo tên trường, kiểu dữ liệu, mô tả tên trường, các thuộc tính của trường. 

Câu 69: Table trong Access có các chế độ làm việc là: 

A. Chế độ thiết kế (Design View).  

B. Chế độ xem trước khi in (Print Preview). 

C. Chế độ trang dữ liệu (Data Sheet View).  

D. Tất cả đều đúng. 

Câu 70: Trong MS Access thao tác nào sau đây dùng để mở cửa sổ Relationship 



A. Chọn Edit -> Relationship. B. Chọn Tools -> Relationship. 

C. Chọn Insert -> Relationship. D. Chọn View -> Relationship. 

Câu 71: Khi thu nhỏ kích cỡ trường kiểu text, thường gặp phải nguy cơ sau đây: 

A. Dữ liệu được bảo toàn. B. Dữ liệu có thể bị cắt bỏ. 

C. Dữ liệu bị mất hết. D. Tất cả câu trên đều sai. 

Câu 72: Tại sao người ta lại chia trường Hoten thành hai trường Ho và Ten riêng 

nhau? 

A. Không cần thiết phải tách Ho riêng, Ten riêng. 

B. Tách cũng được, không tách cũng đượC. 

C. Nên tách vì sau này ta có thể sắp xếp trên trường Ten một cách nhanh chóng 

và thuận lợi. 

D. Các câu trên đều sai. 

Câu 73: Nên dùng trường kiểu dữ liệu (Data Type)  nào cho những chuỗi văn bản 

dài vừa phải (<256 ký tự)? 

A. Text. B. OLE Object. 

C. Memo. D. Loại nào cũng đượC. 

Câu 74: Việc sắp xếp, nói lên: 

A. Hiển thị các mẩu tin thoả mãn các điều kiện truy vấn. 

B. Việc chọn một số các trường và/hoặc các mẩu tin trong một hoặc nhiều bảng. 

C. Việc tổ chức lại các mẩu tin theo thứ tự tăng dần hoặc giảm dần trên trường    

nào đó. 

D. Sử dụng các điều kiện And và Or trong lưới thiết kế. 

Câu 75: Thuộc tính nào sau đây quy định hiển thị dòng thông báo được hiển thị khi 

dữ liệu nhập vào trường vi phạm luật được nêu trong Validation Rule.  

A. Indexed. B. Validation Text. 

C. Lookup. D. Caption 



Câu 76: Chế độ nào sau đây cho phép xem hình ảnh của báo cáo với kích thước thật 

và dữ liệu thật. 

A. Print Preview. B. Layout Preview. C. Design View. D. Layout View. 

Câu 77: Thuộc tính nào sau đây hiễn thị tiêu đề cho biểu mẫu khi xuất hiện? 

A. Name. B. Default View. C. Caption. D. Detail. 

Câu 78: Thuộc tính nào sau đây ràng buộc dữ liệu không cho phép đưa giá trị Null 

vào trường? 

A. Required. B. Default Value. C. AlloZeroLength. D. Validation 

Rule. 

Câu 79: Kiểu dữ liệu nào tốt nhất cho một trường lưu trữ các địa chỉ trang Web 

A. Hyperlink. B. Memo. C. Text. D. Ole. 

Câu 80: Trong phần thuộc tính của trường, thuộc tính Caption... 

A. Dùng để xác định giá trị tự động đưa vào trường khi tạo bản ghi mới. 

B. Quy định cách hiển thị và in dữ liệu. 

C. Cho phép thay tên trường bằng một phụ đề dễ hiểu với người dùng khi hiến 

thị. 

D. Cho phép đặt kích thước trường. 

Câu 81: Dữ liệu nguồn để tạo mẫu hỏi có thể là: 

A. Từ các Fields và Records. B. Từ các tables và Queries 

C. Từ các Queries. D. Từ các Tables và Report. 

Câu 82: Khi chọn kiểu dữ liệu cho trường số điện thoại (vd: 0501.3742885) nên chọn 

loại nào?   

A. Text hoặc Memo B. Autonumber hoặc Yes/No. 

C. Date/Time hoặc Currency. D. Number hoặc Text 

Câu 83: Công dụng nào sau đây không thuộc công dụng của thuộc tính Input Mask? 

A. Kiểm tra tính hợp lệ cho mỗi ký tự gõ vào. 

B. Tạo khuôn dạng nhập liệu cho dễ nhìn. 



C. Đặt nhãn cho trường. 

D. Che dấu thông tin gõ vào: nghĩa là các ký tự gõ vào được thể hiện thành dấu 

(*). 

Câu 84: Chọn phương án đúng trong thuộc tính Required được thiết đặt là Yes, có 

nghĩa là: 

A. Trường đó phải là khóa chính. 

B. Dữ liệu trong trường không được vượt quá độ dài cho phép. 

C. Trường đó có thể được đặt là chuỗi rỗng. 

D. Bắt buộc trường phải có số liệu. 

Câu 85: Để hiển thị và sắp xếp trường tham gia vào mẫu hỏi, ta thiết đặt ở dòng: 

A. Criteria và Sort  B. Show và Criteria  

C. Sort và Show  D. Field và Sort 

Câu 86: Chọn phương án sai: 

A. Một cơ sở dữ liệu có thể có nhiều bảng. 

B. Bảng là nơi chửa dữ liệu của một đối tượng nào đó. 

C. Các bảng trong CSDL thường có quan hệ với nhau. 

D. Một bảng thường có cùng kiểu dữ liệu.. 

Câu 87: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn lọc những bản ghi theo 

ô dữ liệu đang chọn, thao tác thực hiện lệnh nào sau đây là đúng 

A. Record/Fillter By Selection B. Record/Sort/Sort Ascending 

C. Insert/Colum D. Record/Fillter/Fillter By Form 

Câu 88: Tên cột (tên trường) được viết bằng chữ hoa hay thường:   

A. Không phân biệt chữ hoa hay thường.  

B. Bắt buộc phải viết hoa. 

C. Tùy theo trường hợp.  

D. Bắt buộc phải viết thường. 



Câu 89: Chức năng của Báo cáo(Report):  

A. Giúp tạo giao diện thuận tiện cho việc nhập hoặc hiển thị thông tin. 

B. Dùng để thiết kế, định dạng, tính toán, tổng hợp các dữ liệu được chọn và in 

ra. 

C. Dùng để sắp xếp, tìm kiểm và kết xuất dữ liệu từ một hoặc nhiều bảng. 

D. Dùng để lưu trữ dữ liệu trong CSDL. 

Câu 90: Quan hệ Một-Nhiều được tạo ra khi: 

A. Hai trường trong hai bảng phải là khóa chính. 

B. Trường liên kết dùng trong bảng chính phải là khóa chính, trường trong bảng 

quan hệ không phai là khóa chính của bảng đó. 

C. Không nhất thiết một trong hai trường phải là khóa chính. 

D. Trường trong hai bảng phải có cùng kiểu bản ghi. 

Câu 91: Quan hệ một-một được tạo ra khi: 

A. Một trong hai bảng có một trường là khóa chính. 

B. Hai trường trong hai bảng phải có cùng kiểu bản ghi. 

C. Hai trường trong hai bảng đều là khóa chính. 

D. Hai trường trong hai bảng có cùng kiểu dữ liệu. 

Câu 92: Những khả năng nào dưới đây, khả năng nào không là khả năng của bảng 

biểu? 

A. In dữ liệu dưới dạng bảng, dạng biểu. 

B. Sắp xếp và phân nhóm dữ liệu. Thực hiện các phép tính để có dữ liệu tổng hợp 

trên các nhóm. 

C. Sắp xếp dữ liệu trước khi in. 

D. Lọc ra các bản ghi thỏa mãn điều kiện. 

Câu 93: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn tìm kiếm những bản ghi 

theo điều kiện nào đó, thao tác thực hiện lệnh nào sau đây là đúng   

A. Insert/Colum B. Edit/Find/<điều kiện> 



C. Record/Filter By Selection D. Record/Filter/Filter By Form 

Câu 94: Giả sử trường DiaChi (địa chỉ) trong bảng NhanVien được khai báo kiểu 

Text, phần thuộc tính Field Size được nhập 20 có nghĩa là: 

A. Có thể nhập dữ liệu cho trường 20 kí tự không kể kí tự số. 

B. Có thể nhập dữ liệu tối đa cho trường là 20 kí tự. 

C. Phải nhập dữ liệu tối thiểu cho trường là 20 kí tự. 

D. Phải nhập dữ liệu cho trường đủ 20 kí tự. 

Câu 95: Tên trường(fields) trong access được quy định như thế nào? 

A. Nó không theo một quy cách nào cả 

B. Không bắt đầu là chữ số 

C. Không bắt đầu là dấu cách, không chứa kí tự :(.),(!),([),(]),tối đa 64 kí tự 

D. Tuỳ vào người  lập trình nhưng không vựơt quá 255 kí tự. 

Câu 96: Trong Access có mấy đối tượng chính? 

A. 1 B. 2 C. 4 D. 3 

Câu 97: Khi đã tạo một quan hệ giữa hai bảng, nếu muốn sửa đổi quan hệ cần thực 

hiện: 

A. Xoá bỏ hoàn toàn cơ sở dữ liệu và tạo lại 

B. Kích phải vào quan hệ muốn sửa đổi và chọn Edit Relation Ships và sửa đổi. 

C. Xoá bỏ bảng có quan hệ dã tạo và tạo lại bảng mới 

D. Không thể thay đổi được một quan hệ khi nó đã được tạo ra 

Câu 98: Để thiết kế trường đongia kiểu Currency để khi nhập dữ liệu có dạng như 

12000vnd, Chọn thuộc tính nào trong các thuộc tính sau 

A. trong mục default value gõ:”vnd” B. trong mục format  gõ: 0”vnd” 

C. trong mục input mask gõ :0”vnd” D. trong mục format  gõ:”vnd” 

Câu 99: Biểu tượng của Label là hình nào? 

A. Hình có chữ Aa  B. Hình có chữ Ab  



C. Hình có chữ ab|  D. Hình có chữ xyz 
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